
Detention Pond  Section 7b 

In this example you will: 

• Learn more about Flow Control or Minimum Requirement 6 in the Highway 
Runoff Manual (HRM). 

• Review the definition of a Detention Pond as presented in the HRM. 

• Create an inflow hydrograph for the detention pond using the hydrograph 
subtraction command. 

• Display the hydrographs. 

• Create a stage storage detention pond. 

• Model three different outlets including: sizing an orifice, an orifice/weir combo, 
and a drywell. 

• Route a hydrograph through the detention pond using three different outlet 
structures.
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Detention Pond Example Detention Pond Example 
A section of highway near the city of Spokane (Climatic Region 3) is to be improved 
with an additional lane in each direction.  Design a detention pond (BMP FC.03) using 
the data below, as well as the flow control guidance and design criteria on the following 
pages. 

A section of highway near the city of Spokane (Climatic Region 3) is to be improved 
with an additional lane in each direction.  Design a detention pond (BMP FC.03) using 
the data below, as well as the flow control guidance and design criteria on the following 
pages. 

• The existing configuration consists of two 12-foot lanes• The existing configuration consists of 

 

two 12-foot lanes with a 6-foot shoulder 
on one side and an 8-foot shoulder on the other in each direction.   

• The north and south bound lanes are separated by a 50-foot grassed median. 

 
38ft 50ft 

2%
38ft  

2%
 

 

• The proposed project will add one 12-foot lane in each direction on the inside 
into the median, while maintaining the current shoulder widths.  

• The pavement is sloped 2% towards a “V” shaped median acting as a 
conveyance system with 4:1 side slopes.  

 

2%
50ft 26ft 

2%
50ft 

 

 

 

• The roadway profile is 2500’ long on a continuous 5%. 

 2500ft 
 

 

 

 

• No off-site drainage enters the project area. 

5% 

• The median area is grassed with no appreciable amount of brush and the soil in 
the project vicinity has a NRCS identification as Spokane.  From the TR55 CN 
Tables in Appendix 4B in the HRM, Table 4B-1 rates Spokane soils as Type C.  
From Table 4B-3 for EWA, Meadow cover for type C soils has a CN=71. 

• The existing roadway contributes 4.36 acres of impervious runoff and the 2.87 
acres of pervious runoff. 

• The proposed project will contribute 5.74 acres of impervious surface and 1.49 
acres of pervious runoff. 
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Flow Control Definition 
Flow control is Minimum Requirement 6 in the HRM.  Unless an exemption applies (see 
section 3-3.6 of the HRM), any project that adds 5,000 square feet or more of net-new 
impervious surfaces in a TDA must provide flow control of stormwater runoff.  The 
objective of flow control is to prevent increases in the erosion rates beyond those 
characteristics of natural or re-established conditions.  The intent is to prevent cumulative 
future impacts from increased stormwater runoff volumes and flow rates on streams and 
off WSDOT ROW.  Whenever possible, infiltration should be used to provide flow 
control. 

Flow Control Design Guidance 
Unless an exception applies, the flow control design criteria for detention facilities, 
summarized in Table 3-7, should be followed.  The goal is to maintain the pre-existing 
runoff rates at the project location after the proposed project has been constructed.  
Whenever possible, infiltration should be used to provide flow control.  If infiltration is 
not possible, runoff should be detained in a detention pond and released at the rates 
shown in Table 3-7. 

Table 3-7. Eastern Washington flow control criteria. 

Facility Type  Criteria  Model  
Single Event Model  
(SCS or SBUH)  
Climatic Regions 1–4  
Regional Storm; OR  

Detention/combination 
treatment and detention 
facilities  

Provide storage volume required to match ½ of the 2-
year predeveloped peak flow rate and match the 
predeveloped 25-year peak flow rate, and check the 
100-year peak flow for property damage.  Type 1A Storm for Climatic 

Regions 2 & 3 only 

Single Event Model  
(SCS or SBUH)  
Climatic Regions 1–4  
Regional Storm; OR  Infiltration facilities  

Size facility to infiltrate the entire volume of the 25-
year storm with an overflow, and check the 100-year 
peak flow for property damage, or infiltrate 100 % of 
the storm runoff volume.  Type 1A Storm for Climatic 

Regions 2 & 3 only  

As noted in the Model column of Table 3-7, the volume from the Regional Storm for 
Climatic Regions 1–4; OR Type 1A storm for Climatic Regions 2 and 3 should be used to 
size the detention facility. 

In many instances, the 2-year pre-developed flow rate is zero cubic feet per second, or the 
flow rate is so small that it is impracticable to design a pond to release at the prescribed 
flow rate from an engineered outlet structure.  In these cases, the total post-developed 2-
year storm runoff volume must be infiltrated (preferred) or stored in a retention pond for 
evaporation, and the detention pond designed to release the pre-developed 10- and 25-
year flow rates.  See BMP FC.03 Detention Pond in Section 5-4.2.3 for pond and release 
structure design information. 
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Down Stream Analysis 
Any outfall that leaves WSDOT Right of Way is required to have a Down Stream 
Analysis (DA) as part of the Hydraulics Report.  A DA examines the impacts an outfall 
will on a conveyance system downstream of the project site.  Section 4-7 of the 
Hydraulics Manual provides details of the analysis. 

Detention Pond Definition 
Detention ponds are open basins that provide live storage volume to enable reduction of 
stormwater runoff flow rates and allow matching of predeveloped flow durations 
discharged from a project site.  Detention ponds are commonly used for flow control in 
locations where space is available for above ground facility but where infiltration of 
runoff is infeasible.  

Design Criteria 
The following is a summary of section FC.03, Detention Ponds from the HRM. 

• Detention ponds are designed to drain completely within 72 after a storm event so 
that the live storage volume is available for the next storm. 

• The pond should with 1’ of freeboard above the 25 year design storm and the 
designer should verify the 100 year storm does not cause any damage to 
downstream property. 

• Generally the facility is sized by subtracting the existing basin runoff from the 
proposed basin runoff and using that volume as a starting place to size the pond.  
This is done so the detention pond contains additional runoff from the proposed 
basin, while maintaining the runoff conditions from the existing basin. 

• Ponds must be a minimum of 5’ from any property line or vegetative buffer and 
100’ from any septic tank or drain field. 

• The interior of the pond should be hydroseeded up to the 100 year elevation. 

• Follow the guidelines in section 5-3.7.1 from the Highway Runoff Manual, to 
provide maintenance access to the ponds. 

• A primary overflow (usually a riser pipe within the outlet control structure) must 
be provided for the detention pond system to bypass the 100 year developed peak 
flow. A secondary emergency overflow can be provided as additional protection 
against overflows should the designer feel that the primary overflow would likely 
become plugged. 

In addition to the guidelines noted above, designers should review the process for 
designing flow control facilities in EWA outline in section 4-4.5 of the HRM.  This 
tutorial was developed using the outline and sections are noted throughout in blue. 
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Start a new project 

To start a new project in StormSHED, we first need to name a 
new project. 

• Open StormShed 3G and select File>New from the 
main toolbar. 

• Create a new project by selecting: File>New 

• Enter the project name widening in the New Project Name input field and hit 
OK. 

 
Determine Rainfall Depths 

Rainfall Setup 
Open the Project Configuration dialog box by selecting Data>Config from the program menu. 
Using the methods described in the Regional Storm Tutorial, determine the precipitation values 
and input as shown below and click on the Close button to close the dialog box. 

 
• Change the precipitation for the 2 yr 24 hour event to 1.4 inches. 

• Change the precipitation for the 6 mo. event to 0.97 inches (Appendix 4D notes 
that the 6 month storm for Spokane is 0.69*2 yr storm or 1.4*0.69 = 0.97) 
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Determine the predeveloped and postdeveloped time of concentration. Determine the predeveloped and postdeveloped time of concentration. 

Select the storm hyetograph and analysis time interval. Select the storm hyetograph and analysis time interval. 

For each TDA input the values in to StormSHED. For each TDA input the values in to StormSHED. 

Defining Drainage Areas Defining Drainage Areas 

Create Existing Basin Create Existing Basin 

First define the existing drainage area then work from left to right going through the tabs. First define the existing drainage area then work from left to right going through the tabs. 

• Double Click on the “PROTOTYPE” record under the “Basins • Double Click on the “PROTOTYPE” record under the “Basins 

• Click on the New Basin button • Click on the New Basin button 

• Modify the AutoLabel Dialog to “Existing• Modify the AutoLabel Dialog to “Existing” 

• Press the OK button to close the dialog box 

• Change the “Rainfall Type” to Type 1A. 

 
• Click on the “Perv CN” tab. 

• Click on the “Prototype subarea” line. 

• Modify per Figure below 

 
• Click on the Update button. 
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• Delete any default areas that are not used. 

  Both the north and south bound lanes drain inward toward the median.  Then it 
drains down the center of the median to the point of analysis. 

• Click on the “Perv TC” tab. 

• Click on one of the default travel time reaches to modify it. 

• Make it Shallow flow, 25 feet in length with a slope of 25%.  For the coefficient, 
use Short Grass  to depict the median. 

• Click on the Update button. 

• Modify the “Flow Type” drop down to int. Channel. 

• Change the description to Grassed reflect drainage down the ditch. 

• Change the length to 2500 feet with a slope of 5%. 

• Select Grassed for the coefficient. 

• Press the Add button. 

• Delete any default areas that are not used. 

 
• Add the roadway drainage area and CN value of the project site. 

• Click on the “Directly Connected CN” tab. 

• Modify per Figure below and press the Add button. 

 
• Add the Sheet flow shown in the figure below. 
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• Click on the “Directly Connected TC” tab.. 

• Make it Sheet flow, 38 feet in length with a slope of 2%. For the coefficient, use 
Smooth surface to depict the roadway 

• Click on the ADD button 

Create Developed Basin 

The “Existing” basin can now be used as a template for the developed basin.  This will 
save time, as all the values entered will remain as defaults  The designer will only need to 
modify the numbers that are different. 

• Double click on the “Existing” basin under the “Basins” node in the Tree View. 

• Press the New Basin button. 

• Enter new basin for the Basin ID. 

 
• Press OK to close the “AutoLabel” dialog box. 

• Click on the “Perv CN” tab. 

• Modify the Type B soils area to 1.49 acres. 

• Click the Update button  
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• Click on the “Perv TC” tab 

• Modify half the roadway Shallow flow to 13ft 

• Click the Update button  

 
The last step is to modify the impervious roadway for developed conditions. 

• Click on the “Directly Connected CN” tab. 

• Modify the Roadway drainage area to 5.74 acres. 

• Click the Update button  

 
• Click on the “Directly Connected TC” tab 

• Modify half the roadway Sheet flow to 50ft 

• Click the Update button 
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Estimate the Pond Size 
We are going to estimate the pond size by subtracting the existing and new basin 
hydrographs. 

• From the Layout View menu, select the tab marked >Hydrograph Click on the 
“Subtract” tab. 

• Input the values shown below for the 25 year Design Event and hit Subtract.  
Repeat using the 100 year Design Event. 
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The results are shown in the lower box.  We are interested only in the ‘Result Hydro 
Peak Vol’.  0.22 acft, which will be used as a starting place to design the pond. The 
‘Remainder Hydro Peak’ is the same as the existing basin or the volume that will be 
released from the pond (as opposed to the result hydro peak vol being contained in the 
detention pond).  A more detailed description of the difference between ‘Result’ and 
‘Remainder’ is described in the ‘Hydrographs in 3G Description’ Section later in this 
tutorial. 

Have StormSHED compute a hydrograph 

Create a hydrograph 
Next we will create a hydrograph given the data we have input into StormSHED so far.  
Using the subtract function does not create a hydrograph, it only computes the peak Q 
and volume.  To view the hydrograph, follow the directions outlined in the bullet items 
below: 

• To see the hydrograph select the ‘Plots’ tab, located right below the 
‘Hydrograph’ tab in the Layout View. 

• Select the ‘design pond’, ‘existing’, and ‘developed’ (to select all three, hold the 
control key down and use a single LMB click on each name).  

• The Type of Plot we want is a hydrograph. 

• The Hydrograph/Basin List, allows the design to only display hydrographs or 
basins or both in the column on the left side.  We want both so, select the List 
Both radio button. 

• From the Design Event pull down menu, select 25 year. 

• Next select the ‘Plot’ tab to see the Hydrograph for the options we selected. 
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A Hydrograph looking similar to the one below should appear. When the developed 
hydrograph (green) and the existing hydrograph (yellow) are subtracted, the new 
hydrograph created is ‘design pond’ in red (or the area that needs to be stored in the 
detention pond. 

 

Hydrographs in 3G Description 
In the Hydrograph Subtract Tab, there were two names required to save the hydrographs 
‘Result Hydro Peak’ and ‘Remainder Hydro Peak’, this section provides a more detailed 
explanation of these terms.  In the example we were only concerned with the ‘Result 
Hydro Peak’ or the black area shown below, which is the difference between the runoff 
generated from the existing basin and the runoff generated from the proposed basin.  The 
white area represents the existing basin or the ‘Remainder Hydro Peak’. 

 
Overlap Hydrograph 

If the hydrographs were actually offset, they might look like what is shown below. Where 
the black hydrograph is the developed basin and the combination of the aqua and white is 
the existing. When the existing is subtracted from the developed, the area shaded in black 
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is the area that is required for storage and the area in aqua is the remainder runoff, from a 
detention perspective; it is the volume that will theoretically be released from the pond.  
In this case the sum of the subtracted and remainder hydrographs would have the same 
volume as the developed hydrograph.  

is the area that is required for storage and the area in aqua is the remainder runoff, from a 
detention perspective; it is the volume that will theoretically be released from the pond.  
In this case the sum of the subtracted and remainder hydrographs would have the same 
volume as the developed hydrograph.  

 
Offset Hydrograph 

For the offset hydrograph, the Subtract feature doesn't concern itself with the area in 
white, it only reports the subtracted area and the remainder area.  

Assume the size of the detention facility 

Define a Storage Element 
For this project we will be designing a Stage Storage Pond with different outlets. The 
first-step is to design a Stage Storage pond. 

• In the Tree View, double click on the node “PROTOTYPE” record. 

• Click on the New Node button and change the “AutoLabel” ID to Pond45. 

Press the OK button to close the “AutoLabel” dialog box.The Start El is the 
bottom pond elevation, for now leave it at 108ft., StormSHED 3G will 

automatically change these values once the stage-storage table has been created. 

On the next page is the detention pond plan and cross sectional views, including staged 
elevation and volume information. 
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Plan View of Odd Shape Cross Section View of Odd Shape Pond 

  

  

  

  

  

  

  

702cf

1972cf

3938cf

6728cf
205ft

204ft

203ft

202ft

200ft
201ft

11090cf

The dimensions are selected using the area available for a pond and the volume from the 
100 year storm (the subtracted volume from the existing and developed hydrograph) of 
about 11090 cubic-feet with a depth of five (5) feet. The volume per stage can be 

The dimensions are selected using the area available for a pond and the volume from the 
100 year storm (the subtracted volume from the existing and developed hydrograph) of 
about 11090 cubic-feet with a depth of five (5) feet. The volume per stage can be 
calculated using Inroads for odd shape ponds.  On a real project, the designer might use 
this process when right of way is limited and to try to fit a pond in the space available. 
Then the odd shape could be input into 3G using a volume per stage as noted above and 
illustrated on the next page. If space was not limited, the trap pond command could be 
used till the desired volume was achieved (see the Infiltration example).  

• Input the values from InRoads into the Stag-Storage Table tab as shown below. 

• Verify the Stage-Volume radio is selected. 

• Select the ‘pond 45’ tab and note the bottom elevation has automatically changed 
to 205 feet. 

• Hit ‘Ok’ to close the box. 
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Assume the size of the orifice and input into StormSHED (a good estimate is 1 inch 
diameter orifice per 0.05cfs outflow). 

Define a Control Structure - Orifice 
We will start with a multiple orifice control structure and let the program size the orifice 
diameters. 

• Double click on the PROTOTYPE record found under the “Discharge” node in 
the Tree View. 

• Press the New Control button. 

• Replace the “AutoLabel” Control ID with Orifice. 

• Press OK to close the “AutoLabel” dialog box. 

• Change the Control Type to “Multiple Orifice”. 

• Change the “Outlet Elev” to 200. 

• Change the “Max Elev” to 205. 

     

  
• Click on the “Multiple Orifice” tab. 

• Change the “Lowest Orif Elev” to 198.5 feet and then select CLOSE. 
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It is assumed that the pond bottom elevation is 200 ft and the maximum depth is five (5) 
feet above that.  The program will size the orifice dimensions, so leave all control 
dimensions at zero.  The lowest orifice elevation is set at 1.5 feet below the outlet 
elevation; see the Multiple Orifice Structure above.  The lowest orifice elevation allows 
you to physically locate the orifice, but does not affect its discharge rate.  For the lowest 
orifice elevation the discharge is always computed as the head on the outlet.  Note that 
the flow through the other orifices in the multiple orifice structure is based on the driving 
head from the water surface to the orifice, not the outlet elevation. 

Define the Detention Pond Node 

• Double click on the PROTOTYPE node record found under the “Nodes” category 
in the Tree View. 

• Press the New Node button and change the “Node Auto ID” to MedianPond45. 

• Press the OK button to close the “AutoLabel” dialog box. 

• Change the “Node Type” to Level Pool. 

• Change the description to pond and orifice. 

Notice that again, the “Start El” and “Max El” are not changed, they will change 
automatically based on the data input into the Detention tab. 
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• Select the Detention tab. 

• From the “Storage ID” drop down, select Pond45. 

• From the “Discharge ID” drop down select Orifice. 

• Click back on the “medianpond45” tab 

 
Notice that the program automatically updated the Start and Max elevations. 

 
• Click on the OK button to close the “Node” dialog box. 

Sizing the Control Structure 
The program will automatically design multiple orifice structures to meet the design 
requirements. 

• Select the Pond Design tab in the Layout View. 

• Using the pull down menus, input the values shown below for the 2, 25, and 100 
year design event, selecting the Add button after each input. 
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• Note the 2 year storm should only have 50% of the rate. 

• All data in the dialog box is selected from the associated drop downs except for 
the “Out Hyd” column.  This column specifies the ID’s for the hydrographs that 
are routed through the pond and is automatically named by StormSHED.  

 
• Press the Size Outlet button. 

Next we will review the multiple orifice sizes StormSHED selected and see if they are 
practical and/or constructible.  

• Open the Orifice dialog box and select the Multiple Orifice tab to view the orifice 
sizes.  

• Next, designers need to look at the dimensions StormSHED selected for the 
orifice and apply engineering judgment.  Examine the orifice discharge structure.  
Note that the lowest orifice is 3.8 inches in diameter and is located at our input 
elevation of 198.5 feet. The second orifice is 8.44 inches in diameter and is 
located a distance of 0.6 feet from the outlet elevation of 200 feet, see the 
multiple orifice diagram on the previous pages. The program uses the standard 
orifice equation to compute discharges through each orifice.  
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Designers should change the orifice sizes to something nominal. 

• Modify the Multiple Orifice diameters and distances to match as shown below.. 

 
Use the computer model to route the hydrographs through the detention facility and 
orifice structure.  

Adjust the volume and discharge structures and keep running the computer model 
until the released flows and detention pond design requirements are met. 

• Then select OK and return to the Pond Design tab. This time select the Compute 
button.  Then we will verify the following: 
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• The Peak Out Q does not exceed the Match Q for both the 25 and 2 year 
storm. Note the Match Flow for the 2 year is the full flow and should be 
multiplied by 50% to verify the Peak Out is not greater. 

• There is 1’ of free board above the 25 year pond elevation. 

• The 100 year elevation does not exceed the top of pond elevation at 205’. 

 
For the 2-year storm, the Peak Out Q slightly exceeds Match Q.  For this tutorial the two 
numbers are close enough.  To reduce the Peak Out Q, designers can change the orifice 
sizes and spacing and then re-compute the pond design until the Peak Out Q is less or 
equal to the Match Q. 

All the other requirements are met, so this pond size meets the design criteria for flow 
control and detention ponds. 

Adjust the basin to include the surface area of the pond 
This is a brand new requirement for the next revision (after the 2006 HRM) the upcoming 
revision to the HRM.  The idea is since precipitation falling on the pond will also 
contribute to the pond volume, it must be included in the analysis as impervious surface.  
This will take atleast two iterations to properly size the pond: once to estimate the pond 
size without the pond contributing and a second time to see if the pond size can handle 
the additional volume for the pond itself. 

Modify Developed Basin 
Next we will modify the Developed Basin to include the surface area of the pond. 

• Open the basin called New Basin. 

• Select the Directly Connected CN tab. 
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• For the Description input pond (11090cft/5ft) (converted to acres), 0.05 acres for 

the Subarea, and 98 for the CN. 

• Select the Add button and close the dialog box. 

• Return to the Pond Design tab and select the Compute button. 

The results that include the surface area of the pond are shown below. 

 
Check the 100-year release rate, compare to predeveloped conditions, and check for 
potential property damage. 
The pond still meets the flow control requirements and the design criteria for detention 
ponds, there fore the design is acceptable.  The peak discharge rate for the 2 year storm 
slightly exceeds the 50% requirement.  Designers should consider changing the orifice 
size or spacing to bring this value to 50%. 

Define a Control Structure – Orifice and Weir Combo 
Next we will repeat the process with a weir set at the 25-year elevation from the pond 
design using the orifices, 203.38 and create a combination discharge structure to 
recognize both the weir and the orifice.   

• Double click on the PROTOTYPE under the “Discharge” node in the Tree View. 
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• Click on the New Control button and enter Weir in the “AutoLabel” dialog box. 

• Press the OK button to close the “AutoLabel” dialog box. 

• Fill in the remaining data for the weir as shown in below. 

• Select the Rect Weir tab and change the length to 5 feet. 

The weir length is an arbitrary number we are starting with.  The program will not size 
the weir.  The only discharge structure that the program will size is the multiple orifices. 

 

 

 
• Click on the OK button to close the weir dialog box. 
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Since we have two discharge structures, we need to create a combination node to model 
the orifice and the weir.  

• Double click on the PROTOTYPE node under the “Discharge” records again. 

• Press the New Control button and input Combo. 

• Press the OK button 

• Change the Description to “combination discharge structure” 

• Change the “Control Type” to combination. 

Notice that the starting and max elevation input fields have been disabled and the 
elevations are not correct; this will change once we input the discharge structures. 

• Click on the “Combination” tab 

• Select Orifice and then the Add button. 

• Select Weir and then the Add button. 

 
• Click on the “Combo” tab. 

Notice that StormShed has updated the disabled fields for elevations. 

• Press OK to close the dialog box. 

There is more to change. The orifice structures 2nd diameter needs to be deleted, the weir 
has replaced it. 

• Open the “Orifice” discharge structure and select the “Multiple Orifice” tab. 

• Zero everything except the “Lowest Orifice Diameter” as shown below. 

• Press OK to close the dialog box. 
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The last step before re-computing the peak pond elevations is to modify the Detention 
Pond node with the new combination discharge structure. 

• Open the “MedianPond45” node record and select the “Detention Pond” tab. 

• Change the “Discharge rating curve” from to Combo. 

• Press the OK button. 

 
 

• Open the pond design dialog box by clicking the right mouse button in the white 
space of the tree view. 

• Press the Compute button. 

The “Size Outlet” button cannot be used because the discharge structure is no longer just 
an orifice. 
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Results 
The table above meets all our design requirements.  It releases the pre-developed flows 
and the peak stage in the pond did not go above the maximum proposed elevation, in-fact 
the designer might consider reducing the pond size making certain the pond does not 
overtop during the 100 year storm.   

If the Peak Out Q had been too high for the 25 year storm, designers could reduce the 
width of the weir to reduce the flow. 

Define a Control Structure – Drywell 

The last outlet for our detention pond is a drywell. For this tutorial we will use an 
discharge of 1 cfs, however the method for determining the discharge from a 
drywell is changing and we will notify designers how and when to use the new 
method. 

• Double click on the PROTOTYPE record found under the “Discharge” node in the 
Tree View. 

• Press the New Control button. 

• Replace the “AutoLabel” ID with Drywell. 

• Press OK to close the “AutoLabel” dialog box. 

• Change the Control Type to “stg-disch” or staged discharge. 

• Change the “Outlet Elev” to 200. 

• Click on the “Stage-Discharge rating table” tab. 
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• Change the stage and discharge to match below.  

• Press OK to close the “Discharge Control Definition” dialog box. 

 
One final step is needed before re-computing peak pond elevations.  Modify the 
Detention Pond node with the drywell for the discharge structure. 

• Open the “MedianPond45” node record and select the “Detention” tab 

  
• Change the “Discharge rating curve” to “drywell”. 

• Press the OK button. 



Detention Pond  Section 7b 
 

2/15/2008 27 Final 

 
• Open the Pond Design tab and press the Compute button. 

 
Results 
Notice the Peak Out Q for the 2 year storm exceeds the Match Q.  This is acceptable 
because a drywell provides subsurface discharge and in this case the flow control 
requirement is gone. The only parameter we are concerned with is the Peak Storage and 
for both the 25 and 100 year storms the Elevation is below the Peak Elevation.  In both 
cases, we exceed the design requirements in-fact the designer could reduce the pond size.  
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